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1.  Introduction 

The need for transforming conventional government offices into more efficient 

and transparent e-offices, eliminating huge amounts of paperwork has long been felt. 

The eOffice product pioneered by National Informatics Centre (NIC) aims to support 

governance by using in more effective and transparent inter and intra-government 

processes. 

An automated office attempts to perform the functions of ordinary office by 

means of a computerized system. In a manual office scenario, there are thousands of 

letters and files and their manual tracking is not a very easy task. A computerized 

File Tracking System enables users to track these letters and files within seconds. 

Also, dispatch and record keeping are made easy. It ensures proper distribution of 

work load, thus increasing the efficiency of the system and bringing transparency to 

the system. The system simulates the manual system in a digital environment. 

 eFile, an integral part of eOffice suite is a system designed for the Government 

departments, PSU’s, Autonomous bodies to enable a paperless office by scanning, 

registering and routing the inward correspondences along with creation of file, 

noting,  referencing, correspondence attachment, draft for approvals and finally 

movement of files as well as receipts.   

eFile, is a workflow based system that replaces the existing manual handling of 

files with a more efficient electronic system. This system involves all stages, 

including the diarisation of inward receipts, creation of files, movement of receipts 

and files and finally, the archival of records. With this system, the movement of 

receipts and files becomes seamless and there is more transparency in the system 

since each and every action taken on a file is recorded electronically. This simplifies 

decision making, as all the required information is available at a single point.  

 It envisions a paperless office, with increased transparency, efficiency and 

accountability of the organization.  

 A revolutionary product aimed to make office work like never before in the 

history of Indian Governance, is based on the Thirteenth edition of Central 

Secretariat Manual of Office Procedures (CSMOP) of the Department of 

Administrative Reforms & Public Grievances (DARPG), Govt. of India. 
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2. eFile Modules  

Different sections that constitute eFile application are Receipts, Files, Dispatch, 
Migrate Files, DSC, Settings, Notification and so on. Each section comprises of 
different links that helps the user to easily utilize the functionalities of different 
sections of the eFile. 

 

2.1 Receipts 

In eFile system the ‘Tappals/Inwards’ are represented by the term ‘Receipts’. 
In eFile, receipts are created by the CRU (Tappal/Office section) which is further 
attached with the file to get processed and approved from the higher authority. 

 

2.1.1 Receipts (Tappals/Inwards) registration in eFile 

 
The first process in eFile to register a Receipt is, scan the physically received 

paper based receipts in to a pdf document and save it in the computer system. Then 

perform the following steps in eFile application. 

1. Click the Browse and Diarise ( ) option of Receipts menu, as 

shown in Fig.eFile.1:  

 

 Fig.eFile1 
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2. Click the Upload File (    ) button from the Browse and Diarise screen 

to upload the scanned receipt.  

3. Enter the essential details in all the mandatory fields in Browse and Diarise Page.  

4. Click the Generate (    ) button on Browse and Diarise page to generate 
a unique Receipt (Tappal/Inward) number. 

 

There are 10 options provided, those are associated with an Electronic receipt 

created: 

a) Send → User can use this option to send the generated receipts to other user 

to work at a later stage. 
 

b) Put in File → User can use this option to attach the generated receipt to an 

existing live file. 

c) Copy → User can use this option to copy the metadata fields automatically 

and can edit the metadata fields as per requirement and by uploading a new 

scanned receipt document the user can generate a new electronic receipt. 

d) Dispatch → User can use this option to Dispatch the electronic receipt 

e) Details → User can use this option to view the details of the 

generated/received receipts such as Dispatch History, Referenced files, 

Referenced Receipts and Detach Receipts. 

f) Movement → User can use this option to track the Movements of the receipt 

which automatically gets updated as Receipt moves further 

g) Edit → User can use this option to edit the Metadata fields of the Receipt 

before sending it to the intended recipient. 

h) Attach Files → User can use this option to attach the receipt with the File. 

i) Attach Receipts → User can use this option to attach the working receipt/ 

document with the other Receipt(s) irrespective of the receipt nature. 

j) Generate Acknowledgement → User can use this option to generate an 

acknowledgment to a created receipt.  

2.1.2 Sending the Receipt for further action 

By clicking on Send option the user can send the generated receipts to other 

user to work at a later stage. As a result the following send window appears 

(Fig.eFile.2).  By providing the user address in ‘To’ field (Mandatory) the user can 

send the receipt for further actions.  
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Cc → Used to send the copies of the receipt to different user. Multiple user address 

can be entered by providing semicolon (;). 

Set Due Date → Used to provide a due date indication to the recipient.  

Action → Indication given to the recipient what action has to performed on receipt 

Priority → The user can set the priority to process the receipt. (Immediate, Most 

Immediate, Out Today)  

Remarks → Remarks can be typed (if required) while sending the receipt.  

All the above said entries are optional except ‘To” field. 

2.1.3 Inbox 

Inbox option contains the list of all the receipts that are received as an Inward 

Correspondence. User has to click the Receipt number to view the receipt. As a result, 

the user can view the content of receipt along with the details. Character ‘E’ 

symbolizes Electronic Receipt. 

There are 12 Links provided under Receipt Inbox: 

 

 
 

a) Send Back → This link helps the user to reply to the sender of the Receipt. 

Fig.eFile.2 



eOffice Quick Reference Manual 
 

National Informatics Centre (NIC) Page 7 
 

b) Close → This link helps the user to close a receipt by providing the closing 

remarks. 

c) View Draft → User can use this option to view the drafts that are already 

created with receipt. 

The remaining all other link’s functionalities are same as explained in 2.1.1         

 2.1.4 Sent 

Sent option contains a list of all the receipts that are sent as an outward 

correspondence. 

User can view all the sent receipts, by clicking the Sent link under the Receipts 

section. As a result, the Sent Receipts screen appears as shown in Fig.eFile.3. There 

are 4 links provided under Sent Section of receipt: 

 

 

View  → User can use this option to list the Receipts depending upon its current state. 

i.e. (Electronic, VIP References, All) 

User can also Pull back the sent receipt from the intended recipient even when 

the receipt is in the Inbox of the recipient, using the Pull Back ( ) link. In case, 

the recipient has opened the receipt, then pullback option is inaccessible. 

 

 2.1.5 Closed 

Closed option contains a list of all the receipts that are marked as closed as 

shown in Fig.eFile.4. 

User can re-open the closed receipt anytime by clicking the Re-Open option. 

Fig.eFile.3 
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To Re-open any Receipt user has to perform following steps:  

Select the Closed receipt which needs to be Re-Open and click the Re-open 

option available, as shown in Fig.eFile.4.  As a result, a confirm message to re-open 

the receipt will appear. The re-opened receipts will be moved to the inbox by clicking 

on the OK button of confirmation message. 

 

 

 

2.2 Files 

A File is a collection of related records which comprises of Receipts, Noting, 

Drafts, References, and Linked Files. 

2.2.1 Creating a new electronic file in eFile 

Create New option under the Files section helps the user to create an 

Electronic File. 

To create a New File user has to perform the following steps:  

1. Click on Create New option from the Left navigation panel under the File 

section, as a result, File Cover Page screen appears.  (Fig.eFile.5) Add File 

No.  

2. Enter the necessary details on the File Cover Page. Subject Description is a 

Mandatory field along with File No 

3. After  filling  the  necessary  details,   click  the   Continue  Working                       

(  ) button to create a new file.  

Fig.eFile.4 
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As a result, file gets created, along with a unique file number based on the selection 

of heads. (Fig.eFile.5.1) 

 

 

 

 

Fig.eFile.5 

Fig.eFile.5.1 
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User can perform 11 different operations on a file, For instance: 

a) Noting → With the help of this feature user can view the existing notes in a 

file. There are three different view options (View by Name, View by Date and 

View All) available for the user.   

b) Correspondence → With the help of this feature user can attach 

correspondence/ Receipt to the working File. 

c) Draft → With the help of this feature user can create New Draft and View 

existing Drafts in the File.  

d) Reference → With the help of this feature user can attach references 

corresponding to the working File. 

e) Link → With the help of this feature user can Link and delink other eFile(s) 

to the working file. It contains 2 sub links:  

Internal Files: - This sub link helps the user to link/delink any other file 

from within the Organisation  

Linked In Files: - This sub link helps the user to view other Files that are 

linked from some other Organisation with the working file.  

f) Details → With the help of this feature user can view the details file and also 

can view the total number of part files created.  

g) Movements → With the help of this feature user can have a track on the 

Running File and can view all the movements.  

h) Edit → With the help of this feature user can make changes to the cover page 
of existing running file except the Basic and corresponding Heads. 

i) Send → With the help of this feature user can send the File to the Recipient.  
j) Attachment →With the help of this feature the user can attach other related 

Files or Receipts to the working file. 
k) More → With the help of this feature user can Park or Close the working file.  

2.2.2 Sending the File for further actions 

By clicking on Send option the user can send the created file to other user to 

work at a later stage. As a result, the following send window appears (Fig.eFile.6).  

By providing the user address in ‘To’ field (Mandatory) the user can send the file for 
further actions. 

 
Fig.eFile.6 
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Set Due Date → Used to provide a due date indication to the recipient.  

Action → Indication given to the recipient what action has to performed on File 

Priority → The user can set the priority to process the File. (Immediate, Most 

Immediate, Out Today)  

Remarks → Remarks can be typed (if required) while sending the File.  

All the above said entries are optional except ‘To” field. The user can also provide a 

notification alert through email/sms to the recipient. 

2.2.3 Inbox 

Inbox option contains the list of all the Files that are received by the user for 

further actions. User has to click the File No. to view the Content of the file 

(Notes/Correspondence/Draft etc.).  

The following Fig.eFile.7 shows the File inbox listing Screen. 

 

 

1.   The Priority of the file (Blue – Out Today, Red – Most Immediate, Green 

– Immediate) 

2.  The file with Yellow Note  

3.   File with Draft 

4.  File with Note in draft Stage 

5.  File with attachment (Other Files/Receipts) 

6.  The Remarks provided by the sender while sending the file can be viewed 

by clicking on this icon. 

Fig.eFile.7 

http://117.239.77.90/eFile/?x=5uoMQY4ZhXsskyTCZBVe9FqsO56f3Lpx
http://117.239.77.90/eFile/?x=5uoMQY4ZhXsskyTCZBVe9FqsO56f3Lpx
http://117.239.77.90/eFile/?x=5uoMQY4ZhXsskyTCZBVe9FqsO56f3Lpx
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User can perform 12 different operations on a file, which is opened form the 

inbox 

 

2.2.4 Various actions performed in an electronic file 

The various operations that can be performed on electronic file which is opened from 

the Inbox are as follows (Fig.eFile.8). 

 

 

(a) Writing Green Note 

Commonly used method for writing notes in a file. Green Note cannot 

modify/delete/cancel after the file is forwarded for further actions. 

The user can use ‘Add Green Note’ Button to write the green note in a file. 

User will be getting an editor with limited formatting tools; and can type the notes in 

English as well as in local language (Malayalam). The typed notes will be auto saved.   

(b) Writing Yellow Note 

Rarely used mechanism for writing note in a file. It is rough noting 

mechanism. The yellow note can be Edited/Discarded/Confirmed. Once the yellow 

note gets confirmed, noting gets finalized and saved to main Green sheet noting of 

File.  

Fig.eFile.8 
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The user can use ‘Add Yellow Note’ Button to write the yellow note in a file. 

User will be getting an editor with limited formatting tools; and can type the notes in 

English as well as in local language (Malayalam). The typed notes will be auto saved.   

At a time only one noting will be active, either yellow note or Main Green 

sheet note. 

(c) Viewing the previous note 

While typing the new note (green/yellow) in file the user can view the 

previous notes of the file by clicking on the ‘Previous Notings’ Button.  

(d) Quick view Button 

By using this tool, the user can view the Correspondence/ Draft/Previous 

Notes of the file in separate window while typing the new note (green/Yellow). A 

convenient mechanism to view the file’s Note, correspondence and Draft 

simultaneously.    

(e) TOC/Recent/All 

 

TOC → Table of Content of Correspondence/Issues in the File. (List view) 

Recent → This options shows the recently attached Correspondence/ 

Issues in the File. 

All → This option shows all the Correspondence/Issues in the File. 

2.2.5 Creating a new Draft in a File 

To create a new draft in a file first the user has to open the concerned file and 

chose the link Draft → Create new Draft; as a result the following window with a 

word editor will be opened (Fig.eFile.9) then perform the following steps. 

1. Provide the Meta data about the draft by entering the entire mandatory field 

in ‘Draft details’ and ‘Communication details’ category. 

2. The user can prepare the draft by opting any one of the three methods 

available. 

(i) Directly typing the draft content in editor itself 

(ii) Choose the draft template from the ‘Choose From Template’ 

option and add the draft content in it. 
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(iii) Use the ‘Upload File’ option to upload the draft file prepared 

separately by using Microsoft Word / Open Office word 

processing applications  

3. Click on ‘Save’ Button to save the draft. (Draft’s are not auto saved like notes) 

The user can use ‘Quick View’ option to view the notes file/correspondence 

file/other drafts in file while preparing the draft.   

To attach any other supporting document along with draft the user can use 

‘Attach File’ option.  

 

 

2.2.6 Approving and dispatching the draft 

To approve a draft in file the authorised user has to open the concerned file 

first. Then by using link ‘Draft → View draft’ the user can open the draft by clicking 

on the draft No. As a result the user can view the draft content and the Meta data 

about the draft in the following screen (Fig.eFile.10). 

Fig.eFile.9 
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1. The user can use ‘Edit’ button to edit the draft content as well as the Meta 

data about the draft before approving if necessary. The user can use ‘Quick 

View’ option to view the notes file/correspondence file/other drafts in file 

while editing the draft content. If the draft’s get edited the user can use the 

“Save” Button save the draft. 

2. By clicking on the ‘Approve’ button the user can approve the draft. One 

the draft get approved no further change can be possible in the approved 

draft. 

 
 

An approved draft can be dispatched. As result the user will be getting a dispatched 

window as follows (Fig.eFile.11). 

 
Fig.eFile.11 

Fig.eFile.10 
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1. Dispatch by Self → The user can self Dispatch the approved draft 

2. Dispatch by CRU → The user can dispatch the approved draft through CRU. 

(Central Registry Unit/Dispatch section).  

2.2.7 Closing the file 

To close a file the user can use the close option from the Link. 

More → Close File → Close. 

As a result the following window (Fig.eFile.12) will appear. After providing 

the closing remarks the user can ‘Close’ button to close the file. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.2.8 Linking and Attaching of Files/Receipts 

Link a File 

In eOffice, a file can be linked to another file (may be AD file or the section 

file itself). While linking, a copy of the file is attached to the corresponding file and 

not the original file. The original file remains in the Inbox itself.  

Fig.eFile.12 
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Open the file from inbox list by clicking on file No. which is to be processed 

by linking another file. Then perform the following steps. 

1. Click on option ‘Link’  

2. Choose the first option “Internal files” 

 

 
 

3. A new window (Link/Delink) appears on the right side. Click on “Attach” 

 

 
 
 
 

4. Select the file which is to be linked from the list of files which are there in your 

‘inbox’ or ‘completed’ folders displayed in the new window. 

5. Then Click on “Attach” Button. 

Fig.eFile.13 

Fig.eFile.14 
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6. The list of Linked files is shown in right hand side with file nos. 

 

 

 

 

7. The linked file can be viewed in read only mode in a new window by clicking 

on the file no. 

Delink a File 

Open the file from inbox list by clicking on file No. Then perform the following 

steps. 

1. Click on option ‘Link’  

2. Choose the first option “Internal files” 

Fig.eFile.15 

Fig.eFile.16 
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3. Click the check box near the file number 

4. From the “Choose one” option select ‘Delink’  

5. A confirmation message appears and click “OK” to delink the file.  

 

 
 

 

Attach a File 
 Attach file mechanism can be used to process a transfer file from one section 

to other section or it can be used to process a reference file coming from another 

department. The original file will be attached to the routine file when the users do 

this process. The attached file should be detached to close the routine file. 

1. After Opening the routine file, click on the option Attachment → File 

 

 

2. Click on Attach File 

 

Fig.eFile.17 

Fig.eFile.18 

Fig.eFile.19 
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3. Select the file to be attached from list and click on Attach button, give the remark 

and click ‘OK’ 

 

 

4. The attached file’s details will listed as shown in (Fig.eFile.21) below. The file 

can be opened in separate window in read only mode by clicking on file no 

 

 

 Detach a File 

1. After opening the file click on ‘Attachment ->File’, Select the file to be 

detached from list and click ‘Detach File’. 

 

 
 

 

 

Fig.eFile.20 

Fig.eFile.21 

Fig.eFile.22 
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2. Give the remarks and click ‘OK’. The detached file be stored back to inbox 

 

 

2.3 File Migration 

File Migration is the process of converting the old physical files in to 

electronic files which can be processed in eOffice application. To Migrate file the 

user can perform the following steps.  

Follow Step1 if doing file migration first time else follow step2.  

1. Click on "Folder Permission" under “Migrate File" option in the eOffice main 

menu to set folder permission to the user in Document server of the eFile 

application to access the concerned old physical files which are scanned and 

stored in the server. Click on “Save” Button after choosing the department, 

section, name and file folder from the drop down list (Fig.eFile.24). After 

setting the folder permission (one time process) perform the following steps. 

 

 

Fig.eFile.23 

Fig.eFile.24 
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2. Select "Create New" option in "Migrate File" menu. Choose your seat number 

in the "File Number" option.  

 

 

3. Click the "Browse" button to select the file for migration. Select the file from 

the list which is to be migrated. You can use the file search facility to search 

the file by providing the Physical file number in the "Search" box. Then click 

the “Import” button. 

 

 

Fig.eFile.25 

Fig.eFile.26 
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A new panel will appear on the left side showing 'source' on the upper side and 

'Destination' on the lower side. Now we've to transfer the scanned documents from 

the source (Server) side to the Destination (efile) side. (Fig.eFile.27). 

 

 

4. Click on the Notes folder in the Source Side and select all the scanned files. 

Click the 'Notes' folder in Destination side and click the Down arrow Symbol 

in the middle. Continue these steps for all the 'Receipts', 'Issues' and 

'References' if any. Now enter the details of the file like 'Description', 

'Category' and 'Opening Date'. Then click the 'Continue Working' button. As a 

result the following window appears. 

5. Enter the metadata for the receipt and issues (Mandatory Fields should be 

filled) by clicking the 'Edit' icon corresponding to it as shown (Fig.eFile.28).  

 

 

Fig.eFile.27 

Fig.eFile.28 
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6. After filling the Meta data, click the 'Generate' button (Fig.eFile.29). After 

generating the receipts and issues click the 'Finalize migration' option.   

 

 

7. Click the “OK” button in the Confirmation box that appears. Migrated file is 

created and the Migrated Notes will be shown as a link in the Noting side and 

the receipts will be shown in the correspondence side. 

 

 

 

Fig.eFile.29 

Fig.eFile.30 
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2.4 Other useful features available in eFile 

 There many other useful feature available with eFile. Few are explained 

bellow. 

2.4.1 Searching and Tracking of Files/Receipts/Dispatch 

By using “Advanced” search option the user can search all the 

files/Receipts/Dispatch which are all processed in eFile. 

 

 

The user can search the Files, Receipts, and Dispatch by using the tabs ‘File’, 

‘Receipt’ and ‘Dispatch’ respectively. 

By providing the ‘basic parameters’ like Computer No./File No./Receipt 

No./Dispatch No. or Subject the user can track the records. 

User can also use ‘Advanced Parameter’ to search and track the records more 

precisely and effectively. 

  

Fig.eFile.31 

Fig.eFile.32 
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2.4.2 Parking 

The user can park the file using the park feature of eFile system. Parked link 
contains a list of all the Files that are temporary closed and work will be done later 

stage. Pendency of file will be removed if any file is parked. Parked files can be made 
active at any point of time. 

 

The files received in ‘Inbox’ can be parked by performing the following steps. 

1. Open the file form the ‘Inbox’ by clicking on file number. 

2. Click on the ‘Park File’ option in the ‘More’ link, as a result a parking 

confirmation window appears 

3. Provide the Parking due date and Parking Remarks and Click ‘OK’ 

Button. 

The parked file will be listed in ‘Parked’ folder of the Main menu ‘Files’. 

 

 

The Parked files can be un parked  

 

  

Fig.eFile.33 

Fig.eFile.34 
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2.4.3 Pull Up 

The pull up operation can be performed on both the Files and Receipts of 

other user’s (in same section/in just one hierarchy down).  

In case of Files this action can be performed on files which are there in other 

user’s inbox/parked/personal folder created under inbox. 

In case of Receipts this action can be performed on receipts which are there 

in other user’s inbox/ personal folder created under inbox. 

In order to pull up a file/receipt, a user needs to select a source user from the 

Hierarchical View. By clicking on the hierarchical View list, the user can select the 

name of concerned employee from whom the file/receipt is to be pulled up and also 

to see the list of files to be pulled up. 

Once the file (which is being pulled up) has been located, by using the Pull 

up link/icon (pull) the user can Pull Up the file by providing Pull up reason in the 

remarks window. (Fig.eFile.35). 

 

 

As a result the pulled up  file/receipt will be available now in file's/receipt’s inbox 

of the user. 

2.5 DSC (Digital Signature Certificate) 

A Digital Signature Certificate that has the same legal recognition and validity as 

handwritten signatures which implies a process of demonstrating the authenticity of 

a digital message or document.  

eOffice user has to get a digital signature (optional) in USB token from any of the 

certifying authorities like Sify  SafeScrypt, e-Mudhra, or (n)Code. For using the DSC 

token the user has to register the DSC (one time process) using the option DSC 

Registration under DSC section. To register a new DSC ‘Signing Certificate’ link 

is used. The registered DSC information will be listed as shown in (Fig.eFile.36). 

Fig.eFile.35 
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 Note: User has to properly install drivers and the Java Packages for the DSC USB 

Token in the system before registration.  

3. Validating Digital Signature 

If the Digital Signature is showing as a question mark with unknown validity, 

right click the signature and Select "Validate Signature" and perform the following 

steps.   

 

 

 

 

 

 

 

 

 

1. Click on "legal notice" from the new window 

Fig.eFile.37 

Fig.eFile.36 
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2. Select "Signer legal notice 

 

3. Select The tab "Trust"  

 

 

 

 

 

 

 

 

Fig.eFile.38 

Fig.eFile.39 

Fig.eFile.40 
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4. Click "Add to Trusted Identities" and press OK 

  
 

2. Select " Verify Signature"  

 

 

 

 

 

 

 

Fig.eFile.41 

Fig.eFile.42 
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3. Now this signature is Valid 

 

 

 

 

 

 

4. Clearing of Java Cache 

Clearing of Java Cache will enable the user to put digital signature without 

any time delay. 

Linux/Ubundu System 

Open the terminal window by pressing alt+Control+T keys together on 

keyboard then Type the command “jcontrol”. As result the java control panel 

window appears. Now click on Settings. 

 

Fig.eFile.43 
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1. Click “Delete Files” 

 

2. Click OK 

 

Windows System 

Open Java from the Control Panel Window by performing following steps. 

 Select run from the start menu or press Windows key+R on the keyboard. Type 

“control” command and click OK. 

1. Click on settings 
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2. Click on Delete files 
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3. Now press OK 

 

 

 

 

 

 

 

 

 

 

5. eFile MIS Report 

eFile MIS Report is a new module added in eOffice application; can be used 

to generate various kinds of reports for decision making. This module include MIS 

reports like Personal Register (PR) of an employee, Monthly business statements, 

pendency report, GO registers, Dispatch registers etc.   

This module can be accessed by clicking on the  link ‘eFile MIS Report’ in 

the home page of the eOffice application. 
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